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RISC Overview 

Welcome to Runway Incursion Severity Calculator (RISC) 

The Runway Incursion Severity Calculator (RISC) is a tool for categorizing the severity of the 

outcome of a runway incursion. RISC produces standardized ratings and enables comparisons of 

runway incursions between different facilities on an international level. RISC provides a reliable 

method of rating the severity of runway incursions and, can be used for measuring risk of surface 

operations and improving risk management worldwide. 

Assumptions and Caveats 

This calculator is not designed to classify events involving helicopters or vertical flight aircraft in 

the air. If such aircraft are stationary on the ground, they are classified as aircraft on the ground 

and treated by the model as obstacles.  It is also not appropriate for conflicts involving three or 

more aircraft, or pedestrians. 

 

How the Calculator Works 

The foundation for the rating of the severity of the outcome of the incursion is the closest 

proximity, that is, how close the two aircraft or aircraft and vehicle came in vertical and 

horizontal space. The model then considers other factors that influence the probability of a 

collision.  There are several factors, such as aircraft speed, that are relevant, but not usually 

available in incursion reports.  Relevant factors used by the model fall into the following 

categories:  

a. Visibility 

b. Type of aircraft (weight and/or performance characteristics) 

c. Characteristics of avoidance maneuver executed (including time available for pilot 

response) 

d. Runway characteristics and conditions (width, braking action reported) 

e. Degree to which the situation was controlled or uncontrolled (e.g., type of pilot/controller 

errors involved, whether all parties were on frequency, whether the controller was aware 

of all of the parties involved) 

 

Subsumed within each factor are elements. Elements within the factor of visibility are levels of 

RVR (runway visual range), reported ceiling height and visibility, and day/night. Runway 

characteristic factors include the width of the runway in situations in which an aircraft on the 

runway conflicts with an aircraft or vehicle approaching it from the side. This factor also 

includes the runway conditions (dry, wet, braking action reported as poor or fair) in scenarios 

that involve avoidance maneuvers in which braking action is a relevant factor (for example, hard 

braking action, aborted takeoff). There are several elements within the factor 

"controlled/uncontrolled". One element concerns communication issues such as aircraft not on 
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the correct frequency, partially- or totally-blocked transmission, pilot accepting another aircraft’s 

clearance, readback/hearback error, etc. The other elements map to a lack of awareness on the 

part of the controller (for example, the controller forgot about an aircraft) or pilot (for example, 

pilot landed on the wrong runway). 

 

 

The role of the factors is to increase the severity rating beyond that which is suggested solely by 

closest proximity in situations in which closest proximity alone is insufficient to describe the 

risk. That is, an examination of the critical factors determines whether the same outcome could 

reasonably be expected to occur again, given the same situation. For example, consider two 

aircraft that had landed on intersecting runways and stopped 100 meters from each other. In 

perfect visibility and without severe braking executed by either pilot, the outcome that the 

aircraft would come no closer than 100 meters has a higher chance of recurring than it would in 

poor visibility (where there is degraded information for all parties) or with extreme avoidance 

maneuvers having been executed. Similarly, if available response time for one of the pilots was 

extremely short (for example, less than 5 seconds), more variability would be expected in the 

outcome of the pilot’s response (and hence, the severity of the outcome) than if the available 

response time was long. Therefore, each factor that adds to the variability of the outcome of the 

incursion is considered in the rating and the more conservative rating is applied. This means that 

each relevant factor has the potential to make the rating of severity higher than it would have 

been if it were defined solely by the closest proximity. It should be noted that this is not the same 

as basing the rating on the worst possible, or worst credible, outcome of the scenario. The model 

does not rate the severity of the incursion based on everything that could have gone wrong. 

Rather, it looks at the critical sources of variability within the scenario, assigns a weight to each 

factor (and to each element within the factor) that contributes to the variability, and generates a 

rating based on the assigned weights of the factors and the elements within each factor. While it 

may be helpful to think of the weights as scaling the "severity" level of the factor (for example, a 

pilot’s acceptance of clearance intended for another aircraft is more serious than a partially-

blocked transmission), they actually represent the level of variability that the factor introduces 

into the severity of the outcome. 

 

Closest Proximity 

The foundation for the severity classification for the outcome of an incursion is the proximity to 

collision. The model assumes that the closest vertical and lateral (horizontal) proximities entered 

are accurate. There is no logic in the model that can detect proximity values that are illogical 

given the other details in the report. Below are guidelines  for determining the appropriate 

proximity values for incursions involving more than one aircraft or an aircraft and a vehicle. 

  

• The closest proximity is the distance between the two aircraft or between the aircraft and 

vehicle at the end of the conflict.  This is defined as either when both parties have 

stopped or when all parties are aware of the situation and have the aircraft under control 

at taxi speed or less. In most cases, this distance can be represented as a straight line 
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(either vertical or horizontal). For events that involve intersections, however, the closest 

proximity is computed by adding the distance from each aircraft (or aircraft and vehicle) 

to the intersection. For example, if an aircraft that aborted its takeoff stopped 100 meters 

from the intersection with another runway on which another aircraft landed and stopped 

150 meters from the intersection, the closest proximity to be entered into the model is 250 

meters. 

• In an incursion in which there is a vertical and horizontal proximity reported, you may 

use whichever value is more representative of the risk incurred in the event. However, 

vertical proximity should always be used whenever there is a direct overflight, that is, 

whenever an aircraft flies directly over an aircraft or vehicle on takeoff or landing. 

• When proximity between two vehicles was decreased by an intentional maneuver, the 

proximity to which the vehicles came as the result of unintentional actions should be the 

one entered into the model.  For example, if at some point, a pilot or vehicle driver 

elected to go closer to the other aircraft (e.g., so as to  go around each other on a runway), 

the proximity that is entered into the model should be the proximity at which  both 

aircraft were aware of the situation and were under control at taxi speed or less. 

 

Scenarios 

The mechanics of the model start with a set of situations, or "scenarios", that broadly subsume all 

types of runway incursions (with the exception of those involving helicopters or pedestrians). 

These scenarios define the parties involved (for example, two aircraft or an aircraft and a 

vehicle) and the action of the parties at the point of the incursion (landing, taking off, crossed the 

hold short line, etc.). The scenario can involve, for example, two landing aircraft on intersecting 

runways, one landing aircraft and one takeoff aircraft, one landing aircraft and a taxiing aircraft 

or vehicle crossing the runway, etc. The Scenario Selector is a tool that takes the description of 

the conflict and assigns a scenario number that is to be entered into the model. 

Each scenario has a specific table associated with it. The table defines a proximity at or below 

which the classification will always be an "A" and another proximity at or above which, the 

classification will always be a "C".  For proximities in between these extreme values, the severity 

calculation starts with the closest proximity and then assigns a classification based on the 

proximity and a set of factors that are weighted for that scenario.  

 

Errors 

The set of "errors" in the model are the pilot, controller, and vehicle driver errors that contribute 

to the variability of the outcome of the incursion.   Examples include: the controller forgetting 

about an aircraft on the runway, a pilot landing on the wrong runway, a vehicle  crossing the 

runway without a clearance. Communication errors include one of the parties not being on 

frequency, blocked transmissions (two parties try to transmit at the same time), and 

"readback/hearback" errors. A "readback" error occurs when a pilot reads back something 

different from what the controller said. For example, if the controller issued a clearance to land 
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on Runway 23L and the pilot read back the clearance as "cleared to land 23 Right". If the 

controller did not correct the error, this is referred to as a "hearback" error. 

Avoidance Maneuvers 

Avoidance maneuvers describe actions taken by the aircraft and/or vehicle. Examples include: 

  

• Aircraft rotated early on takeoff to avoid a collision 

• Aircraft delayed rotation to avoid a collision 

• Aircraft aborted takeoff (in which case the distance rolled should be reported) 

• Aircraft or vehicle swerved to avoid a collision 

• Aircraft or vehicle applied hard/maximum braking 

• Aircraft executed a go-around (executed a missed approach) 

Incident Types and Ratings 

After the information is entered, clicking the "Calculate Rating" button will display an FAA or 

ICAO alpha rating. In addition to an alpha rating, the RISC model displays the calculated 

numeric value. See Sheridan, 2004 for a detailed discussion of the mathematics behind the 

model. The RISC model calculates ratings for the following incident types.  

  

• Incursion involving two aircraft or an aircraft and vehicle - This category of incursions 

involves a runway and two objects, at least one of them being an aircraft. An example is a 

vehicle crossing a runway in front of an aircraft which is approaching the runway for a 

landing.  

• Incursion involving one aircraft or a vehicle -  An example would be an aircraft that was 

told to hold short of a runway, but crossed the hold-short line before stopping short of the 

runway. 

• Runway Operations on a Taxiway - This category is for incidents involving takeoffs or 

landings on taxiways or ramps with no other aircraft or vehicle present in the area at the 

time of the incident. 

• Runway Operations on a taxiway, with a conflict - This category is for incidents 

involving aircraft that either takeoff, land, or attempt to takeoff or land on a taxiway or 

ramp and conflicts with another aircraft or vehicle. 

  

Note: When entering information into the calculator, the tool allows you to select 

from only three different incident types: an incursion involving two aircraft or an 

aircraft and a vehicle, an incursion involving one aircraft or a vehicle, or a Surface 

Incident. When calculating a rating for Runway Operations on a taxiway or Runway 

Operations on a taxiway with a conflict, select the incident type, Surface Incident. 
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The following table displays the FAA and ICAO ratings, the calculated numeric values, and 

rating description. 

  

 
FAA/ICAO 

Rating 

Calculated 

numeric value 

is 

Rating Description 

Incursions involving two Aircraft, or an Aircraft and Vehicle 

 A >=3.5 
A serious incident in which a collision was 

narrowly avoided.  

 B <3.5 and >=2.5 

An incident in which separation decreases and 

there is a significant potential for collision, 

which may result in a time-critical 

corrective/evasive response to avoid a 

collision. 

 C <2.5 and >1.5 
An incident characterized by ample time 

and/or distance to avoid a collision. 

    

Incursion involving one Aircraft or Vehicle 

 D 
<1.5 and 

>=1.17 

An incident that meets the definition of 

runway incursion, such as incorrect presence 

of a single aircraft or vehicle on the protected 

area of a surface designated for the landing 

and take-off of aircraft, but with no immediate 

safety consequences.   

Runway Operations on a Taxiway 

RT RT - 

Since these are technically not incursions, 

they do not receive an incursion rating. For 

the purposes of the RISC software, these 

events are automatically rated "RT" to signify 

this. 

Runway Operations on a Taxiway, with a Conflict 

RTC RTC - 
These are technically not incursions. For the 

purposes of the RISC software, these events 

are automatically rated "RTC" to signify this. 
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However, the software also calculates the 

RISC rating for the user and does so using the 

same rules had it occurred on the runway. In 

other words, the events will be rated RTC: A, 

RTC: B, or RTC: C. Note: Currently there are 

no scenarios in the model where a landing 

aircraft would go around, so there is currently 

no RTC: D rating. 

RISC Dialog Boxes 

The application consists of the following dialog boxes: 

  

• RISC Main 

The RISC Main dialog box provides access to the RISC (Database Version), RISC 

(Calculator Version), RISC Analysis, RISC Scenario Tool, and the Measurements and 

Settings dialog boxes.  

• RISC Calculator 

Both the RISC (Database Version) and RISC (Calculator Version) dialog boxes allow you 

to enter the details of a runway incursion, and calculate a severity rating. The information 

used to calculate a rating includes data on closest proximity (horizontal and/or vertical), 

visibility and braking conditions, the aircraft or vehicles involved, avoidance maneuvers, 

and pilot or controller errors. 

The RISC (Database Version) dialog box provides the added capability to save incursion 

reports to a database and manage incursion records. 

• RISC Analysis 

The RISC Analysis dialog box provides access to the Average Numerical RISC Rating 

report. The RISC Average Numerical RISC Rating report lists the application's alpha 

ratings for a specified year range, the corresponding average numerical rating, the counts 

for the alpha ratings, and the standard deviation. 

• RISC Scenario Tool 

The RISC Scenario Tool guides you through the process of determining the scenario for a 

runway incursion. Using the tool, you generate a scenario "number" after you identify the 

parties involved, their orientation at the point of the incursion, and the action each party 

took. 

• RISC Measurements and Settings 

The RISC Measurements and Settings dialog box allows you to select the units of measure 

you will use to calculate a severity rating on the RISC Calculator dialog box. 
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Using RISC Dialog Boxes 

Dialog boxes are windows that enable you to specify choices or enter information instructing an 

application on what to do. The following graphic shows the RISC (Database Version) dialog 

box. 

 

 

 

Title Bar 

The title bar displays the name of the dialog box and can be used to drag the dialog box to a 

different location. To do this, with your pointer in the title bar, depress the left mouse button and 

drag the dialog box to a new location.  

Main Menu 

A main menu displays under the title bar providing access to the File and Help menus. To select 

an option on a menu using the mouse, do the following: 

  

1. Click the menu name. A drop-down menu displays.  

2. Highlight an option. 

 

Text Entry 

Field 
 

List Button 

 

 

 

Scroll Bar 

Title bar 

Main Menu 

Toolbar 

 

 

 

 
 

Push Button 
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3. Click the left-mouse button.  

 

To select an option on a menu using the keyboard (for example, File), do the following:  

  

1. Press the Alt and F keys simultaneously. Notice that the File drop-down menu displays 

and the first option is highlighted. 

2. To select the first option, press the Enter key . To select another option, use the down-

arrow key to highlight the option and then press the Enter key. 

 

OR 

 

1. Press the Alt and F keys simultaneously. Notice that the File drop-down menu displays 

and the first option is highlighted. 

2. Press the key for the letter that is underscored in the option name. If no letter is 

underscored, press the key for the first letter in the first word of the option name. For 

example, to select the option Calculate Rating, you would press the R key because the 

letter R is underscored. To select the option Exit Calculator, you would press the E key. 

  

 

 

Note: Press the Alt and H keys simultaneously to access the Help menu. 

Toolbar (Database Version) 

A toolbar under the main menu allows you to manage records in the RISC database. For more 

information on the toolbar see the topic, Using RISC (Database Version). 

Text Entry Field 

Text entry fields allow you to use the keyboard to type in information. If you make an error, 

backspace to remove characters.  

 

Note: The Closest Proximity (CP) text fields accept a numeric value only. 

List Buttons 
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Many text entry fields on the calculator dialog boxes have a list button. A list button provides a 

pull-down list of choices. List buttons are represented by an arrow. To select a list button using 

the mouse, move the pointer over the button and click the left mouse button. A pull-down list of 

choices displays. Highlight the desired selection and click the left mouse button. 

If a text entry field has a list button and you use the keyboard to type in information, do the 

following to avoid receiving an error message:  

  

1. With the cursor in the field, press the F4 key. A pull-down list of choices displays.  

2. Press the down arrow key on the keyboard and highlight the desired selection. 

3. Press the F4 key.  

4. Press the Tab key to move to the next field. 

Radio Buttons 

Radio buttons are used to select one option exclusively from a group of options. To select a radio 

button using the mouse, move the pointer over the radio button and click the left mouse button. 

When one of these buttons is selected, the other options become deselected. To select a radio 

button using the keyboard, do the following: 

 

1. Press the Tab key until a dotted line surrounds a radio button label of any entry in the 

group. In the example below, VMC is selected.  

 

  

2. To move to the Visibility field, press the Tab key. If you want to select another entry in 

the radio button group, press the right or left arrow key until a dotted line surrounds the 

radio button label of the entry. In the example below, IMC was selected using the right-

arrow key. To move to the RVR field, you would press the Tab key.  
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Push Buttons 

Push buttons perform a specific action when selected. The action is indicated by the label on the 

button. 

To select a push button using the mouse, move the pointer over the push button and click the left 

mouse button. To select a push button using the keyboard, simultaneously press the Alt key and 

the key for the letter that is underscored in the button label. The image below displays the Save 

and Calculate button on the RISC (Database Version) dialog box. In this example, you would 

press Alt and C to save the report and calculate a rating.  

  

Note: If the push buttons on a dialog box do not display underscored letters, press the 

Alt key. After pressing the Alt key, the underscored letters will display. 

 

 

Scroll Bar 

Some lists of options are too long to be displayed in a dialog box so only a portion of the entire 

list is displayed at any time. You can use the scroll bar on the right side of the list to view all 

options. 

• To scroll using the arrow keys, press the up arrow to move up one line in the list and the 

down arrow to move down one line. 

• To scroll using the slider, move the pointer onto the slider, depress the left button, and 

drag the slider up or down to move through the list. Then release the button. The position 

of the slider indicates the relative position of the items displayed within the list. 

• To scroll using the trough region, click in the trough above the slider to move up one 

window or below the slider to move down one window. 
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Using RISC Help 

Invoking RISC Help 

To access the Help using the mouse, do the following:  

  

1. Click the Help button on the main menu. A drop-down menu displays.  

2. Highlight the Help option. 

3. Click the left mouse button. 

 

To access the Help using the keyboard:  

  

1. Press the Alt and H keys simultaneously. A drop-down menu displays with the Help 

option highlighted. 

2. Press the Enter key. 

Navigating RISC Help 

The RISC Help contains a navigation pane and a topic window. The navigation pane, located on 

the left-hand side of the screen, allows you to navigate the Help system. The topic window 

located on the right-hand side of the screen displays help topic content. 

 

 

The navigation pane includes the following buttons and tabs: 

 

• Show/Hide Buttons 

• Backward/Forward Buttons 
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• Print Button 

• Contents Tab 

• Index Tab 

• Search Tab 

Show/Hide Buttons 

To hide the navigation pane and view the topic window only, click the Hide button located under 

the title bar. When you click the Hide button, the navigation pane closes and a Show button 

appears under the title bar. To open the navigation pane again, click the Show button.  

  

 

Back/Forward Buttons 

To browse backwards through topics you have previously viewed, click the Back button. To 

browse forward, click the Forward button. 

Print Button 

To print a selected topic or all topics under a selected heading or book, click the Print Button. 

After you click the Print button, a dialog box appears which lets you choose your print option. 

 

Note: A heading or book is selected if it is highlighted in the navigation pane. A topic 

is selected if it is highlighted in the navigation pane and appears in the topic window.  
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Contents Tab 

To scroll through the table of contents for Help, click the Contents tab. The Contents tab 

displays books and topic pages that represent the categories of information in the RISC Help. 

When you double click a closed book ( ), it opens to display its content (sub-books and topic 

pages). When you double click an open book ( ), it closes. When you click a topic page ( ), 

that topic page displays in the topic window. 

Index Tab 

To scroll through or search the index, click the Index tab. Type a keyword in the search field to 

find a matching index term or scroll through the list of index terms. Click on an index term to 

display its related topic(s). A help topic page will automatically open if there is only one topic 

related to the index term. If there is more than one related topic, a pop-up menu will appear with 

a list of topics to choose from. 

Search Tab 

When you want to search for specific terms or phrases, click the Search tab. Type a search term 

in the search field and press the <Enter> key on your keyboard. A list of matching topics is 

generated. Double-click on a topic title to open that topic. 

Viewing Related Help Topics 

To view information related to a particular topic click  at the bottom of a topic 

page. A related help topic page will automatically open if there is only one related topic. If there 

is more than one related help topic, a pop-up menu will appear with a list of related topics to 

choose from. 
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Installing RISC 

RISC System Requirements 

To use the RISC software, your system should be equipped with the following: 

 

• Windows 2000 or higher only 

• Microsoft .NET Framework 1.1 (English version is included on the install CD and 

can be run directly from the install file*) 

• Microsoft Data Access Component (MDAC) 2.6 or higher (2.8 is included on the 

install CD) 

 

Note: RISC software is not supported if it is installed on a machine using Windows 

Vista operating system.  

 

RISC software is best viewed using a display setting of small fonts (96 dpi) and a 

minimum screen area of 800 X 600 or higher. 

 

* Due to limitations with its distributor Microsoft, it is not possible to install more than 

one language version of .NET framework 1.1.  The version that is packaged along with 

RISC is the English version.  If you require a non-English version, please download it 

from the Microsoft website. 
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Running the RISC Setup Wizard 

Before installing the Runway Incursion Severity Calculator (RISC) software, check that 

your system meets the System Requirements for using RISC. To install RISC, do the 

following: 

 

1. Insert the RISC Installation CD into the CD drive on your PC. The RISC Setup 

program will start automatically and display the RISC Setup Wizard's Welcome 

dialog box. Close all other applications before continuing (recommended). To 

continue, click the Next button. You can exit the Setup program at any time by 

clicking the Cancel button. 

  

Note: If Setup does not start automatically, navigate to your CD drive and click 

the RISC_SetUp.exe file in the RISC Installation folder. 

 

 

 

 



RISC User Guide 4.2 

16 

2. On the Select Destination Location dialog box enter the location where you want 

the Setup Wizard to install RISC. Use the Browse button to select a folder other 

than the default folder that appears. To continue, click the Next button. 
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3. On the Select Start Menu Folder dialog box enter the location where you want the 

Setup Wizard to create the program's shortcuts. Use the Browse button to select a 

folder other than the default folder that appears. To continue, click the Next 

button. 
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4. On the Select Additional Tasks dialog box indicate whether you want to create a 

desktop and/or Quick Launch icon for running RISC by clicking the appropriate 

checkbox(es). To continue, click the Next button. 
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5. The Ready to Install dialog box displays your selections for review. To continue, 

click the Install button. 
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6. The Installing dialog box displays. When Setup is complete, the Wizard 

automatically displays the next dialog box. 
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7. On the Completing the Runway Incursion Severity Calculator (RISC) Setup 

Wizard dialog box, click the checkbox if you want to launch RISC after exiting 

Setup. In the example below, RISC is set to launch after exiting. To exit Setup, 

click the Finish button. 
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8. If you selected to launch RISC after exiting Setup, the RISC Main dialog box 

displays. Click the RISC (Database Version) or RISC (Calculator Version) 

button. If installation was successful, the calculator dialog box will display. If you 

encounter an error, see the section on Error Messages. 
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RISC Dialog Boxes 

RISC Main 

From the RISC Main dialog box you can access the RISC Calculator, RISC Analysis 

report, RISC Scenario Tool, and RISC Measurements and Settings. The RISC Main 

dialog box provides push buttons for each option and a Quit button for exiting the 

application. 

RISC Main Calculator Buttons 

The RISC Main dialog box displays two calculator buttons, RISC (Database Version) 

and RISC (Calculator Version). 

Use the RISC (Database Version) button to access the calculator with the capability to 

save incursion reports to a database and manage incursion records. 

Use the RISC (Calculator Only) button if you want to run data through the calculator 

and calculate a rating without adding a new report to the database. 
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RISC Main Menu 

The main menu on the RISC Main dialog box provides access to the File and Help 

menus. 

The File menu provides options for accessing both versions of the calculator, RISC 

Analysis, RISC Scenario Tool, RISC Measurements and Settings, and exiting the 

application. 

The Help menu provides options for accessing Help and viewing the current RISC 

version information. 
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RISC Calculator 

The Runway Incursion Severity Calculator (RISC) tool provides two versions of the 

calculator that are accessed from the RISC Main dialog box. 

If you select the RISC (Database Version) button on the RISC Main dialog box, the 

calculator opens with a "records" toolbar as in the example below. In addition to 

calculating a severity rating, this version of the dialog box allows you to add incursion 

reports to a database and manage saved incursion records. When entering a new 

incursion using this dialog box, you must enter a report number and report date. 

If you select the RISC (Calculator Version) button, the calculator opens without the 

toolbar and the report number and date fields. Use this version of the dialog box when 

you want to run data through the calculator and calculate a rating without adding a new 

report to the database. 
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RISC Calculator Main Menu 

The main menu on the calculator provides access to the File and Help menus. The File 

menu provides options for calculating a rating and exiting the calculator. The Help menu 

provides options for accessing Help and viewing RISC version information. 

  

 

RISC Calculator Toolbar 

The RISC toolbar allows you to manage saved incursion records. The toolbar displays the 

date range of the incursions selected for viewing, allows you to change the date range, 

and provides arrow buttons for browsing selected records. Using the toolbar, you can 

export records to a Comma Separated Value (CSV) file, clear the calculator to enter a 

new report, and delete records from the database. For more information on using the 

calculator with the RISC toolbar options, see the topic Using RISC (Database Version). 

Using the RISC Calculator Dialog Box 

The RISC Calculator dialog box lets you enter data on a runway incursion and calculate a 

severity rating. The information used to calculate a rating includes data on closest 

proximity (horizontal and/or vertical), visibility and braking conditions, the aircraft or 

vehicles involved, avoidance maneuvers, and pilot or controller errors.  

To make an entry, click in a field. Press <Tab> or use the mouse to move from one field 

to another. Several fields provide a list button with a pull-down list of choices. If a field 

has a list button but you use the keyboard to type in information, do the following to 

avoid receiving an error message:  

  

1. With your cursor in the field, press the F4 key. A pull down list of choices 

displays.  

2. Press the down-arrow key on the keyboard and highlight the desired response. 

3. Press the F4 key. Note that the selection is now highlighted. 

4. Press the Tab key to move to the next field. 

 

To generate a scenario number using the RISC Scenario Tool, click the Scenario 

Selector button. To remove a pilot or controller error from the Errors field, select the 

error and click the Remove button. To calculate a severity rating after responding to all 

fields, click the Save and Calculate button.  
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For information on using the calculator to generate a severity rating, see the topic, 

Calculating a Rating. For information on saving incursion reports to the database, see the 

topic, Using RISC (Database Version). 
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RISC Dialog Box Fields 

The following table describes the fields and buttons on the calculator and explains how to 

use them.  

RISC (Database Version) and RISC (Calculator Version) Dialog Boxes 

Item Description What To Do 

Incident Type The kind of incident that took 

place. For more information 

on Incident Types, see the 

topic, How the Calculator 

Works. 

For two objects involving a 

runway, select Incursion 

involving two aircraft, or 

aircraft and vehicle.  For a 

single object involving a 

runway, select Incursion 

involving one aircraft or 

vehicle. For all others, select 

Runway Operations on a 

Taxiway.  

Report Number 
RISC (Database 

Version) only 

The user-assigned number for 

the incursion report. 

Enter a number using any 

combination of alpha and/or 

numeric characters. 

Report Date 
RISC (Database 

Version) only 

The date of the incursion 

report. 

To change the date that 

displays, click the month, 

date, or year in the date field 

and type a new value or use 

the calendar popup. Note: 

You cannot enter a future 

date. 

Conditions 

Day/Night/Unknown The light conditions 

(daylight, darkness) that 

existed at the time of the 

runway incursion. 

Click the radio button that 

corresponds to the light 

conditions reported (Day or 

Night). If the information is 

not available, click 

Unknown. 

VMC/IMC/Unknown The weather or 

meteorological conditions, 

that existed at the time of the 

runway incursion. 

Click the radio button that 

corresponds to the 

meteorological conditions 

reported (Visual 

Meteorological Conditions - 

VMC or Instrument 

Meteorological Conditions - 
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IMC). If you select IMC, 

you are required to provide 

RVR data. If the information 

is not available, click 

Unknown. 

RVR The Runway Visual Range at 

the time of the runway 

incursion. 

Click the list button for a 

pull-down list of choices. 

Choices include, >=18000 

feet, 6000-17999 feet, 4500-

5999 feet, 3000-4499 feet, 

1500-2999 feet, <1500 feet, 

and N/A. 

Visibility The Visibility at the time of 

the runway incursion. 

Click the list button for a 

pull-down list of choices. 

Choices include: >=18000 

feet, 6000-17999 feet, 4500-

5999 feet, 3000-4499 feet, 

1500-2999 feet, and <1500. 

Ceiling The Ceiling at the time of the 

runway incursion. 

Click the list button for a 

pull-down list of choices. 

Choices include. >=1000, 

500-999 feet, 200-499 feet, 

100-199 feet, <100 feet. 

Braking The runway condition at the 

time of the incursion that 

affected the braking action of 

the aircraft.  

  

Click the list button for a 

pull-down list of choices 

including Good, Dry; Good, 

Wet; Fair; Poor; and Nil. 

  

Scenario 

Scenario The scenario defines the 

parties involved (e.g., two 

aircraft or an aircraft and a 

vehicle) and the action of the 

parties at the point of the 

incursion (landing, taking off, 

etc.). It is represented by a 

pre-assigned number and 

describes the circumstances 

of the runway incursion.  

  

Click the Scenario Selector 

button to access the Scenario 

Selector Tool or click the list 

button for a pull-down list of 

choices. Select the pre-

assigned number for the 

scenario involved in the 

runway incursion. 

Avoidance 
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Closest Proximity 

(CP) 

(Horizontal/Vertical) 

The closest proximity or 

distance, horizontally and/or 

vertically, between both 

parties at the end of the 

incursion OR at the point at 

which both parties were 

aware of the situation and the 

aircraft was under control at 

taxi speed or less. 

  

Enter the distance of closest 

proximity (Horizontal and/or 

Vertical) using the unit of 

measure displayed. 

Note: You can change the 

unit of measure for closest 

proximity on the RISC 

Measurements dialog box.  

  

Aircraft/Vehicle Aircraft or vehicle involved 

in the runway incursion. 

The Scenario you select 

determines the list of choices 

available. Click the list 

button for a pull-down list 

that may include the 

following: Landing 

Aircraft, Takeoff Aircraft, 

Taxiing/ Stopped Aircraft, 

Vehicle. 

  

Add Second 

Aircraft/Vehicle 

Allows you to add a second 

aircraft or vehicle.  

Click this button to display 

fields for a second 

Aircraft/Vehicle. 

Remove This button appears after you 

select a second aircraft or 

vehicle. Allows you to 

remove the second aircraft or 

vehicle. 

Click to remove the second 

aircraft or vehicle. 

Maneuver The action taken by the 

aircraft or vehicle involved in 

the runway incursion. 

The Scenario you select 

determines the list of choices 

available. Click the list 

button for a pull-down list of 

choices. For example, 

Landed Over. 

Size Size of the aircraft or vehicle 

involved in the runway 

incursion. 

Click the list button for a 

pull-down list of choices. 

Choices include: S - Small, 

L - Large, H - Heavy, 

Vehicle, and Obstacle 

Errors 

Errors Pilot or controller error(s) 

made during the runway 

Click the list button for a 

pull-down list of choices. For 
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 incursion. example, Completely 

blocked transmission. 

Remove This button appears after 

selecting a pilot or controller 

error. Allows you to remove 

an error. 

  

To remove an error from the 

list, select the error and click 

the Remove button. 

  

RISC Analysis 

The RISC Analysis dialog box provides access to an analysis report you can run on 

incursion data. To access the RISC Analysis dialog box, click the Analysis button on the 

RISC Main dialog box.  
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Using RISC Analysis 

To run the Average Numerical RISC Rating report for the current fiscal year, click the 

Avg Numerical RISC Rating button. The RISC - Average Numerical RISC Rating 

dialog box displays with the report results. 

  

 

 

The RISC Average Numerical RISC Rating dialog box lists the application's alpha 

ratings for the specified date range, the corresponding average numerical rating, the 

counts for the alpha ratings, and the standard deviation. 

To change the start or end date and run the report for a different date range, click the 

month, date, or year in the date field and type a new value or use the calendar popup. 

After specifying the date range, click the Show Results button. The system reruns the 

report for the date range entered and displays the new results. 
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Exporting Report Results 

To export report results, click the Export... button. After clicking OK, the RISC Export 

dialog box opens. On the RISC Export dialog box select the location in which you want 

to save the .Excel file and enter a file name. Click the Save button to save the file. 

Click the Close button to exit the RISC - Average Numerical RISC Rating dialog box.  

RISC Scenario Tool 

The RISC Scenario Tool is accessed from the RISC Main dialog box or by clicking the 

Scenario Selector button on either of the calculator dialog boxes (Calculator or Database 

version). The tool consists of several dialog boxes that guide you through the process of 

determining the scenario for a runway incursion. Using the tool, you generate a scenario 

"number" after you identify the parties involved, their orientation at the point of the 

incursion, and the action each party took. 

 

 

 

The Scenario Selection Tool dialog boxes display a question to guide you through the 

process of determining a scenario. A dialog box, similar to the one below, starts the 
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process. To select a response, position the pointer over the appropriate text and click.  
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After you click on a response, the text is highlighted for an instant and the next dialog 

box opens.  
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Each of the dialog boxes provides a Start Over button that allows you to stop the scenario 

selection process and start over at the beginning.  
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As you proceed through the Scenario Selection Tool dialog, your response to the previous 

dialog box appears to the right of the Start Over button. In the example below, the dialog 

box indicates that 2 landing aircraft were identified as the parties involved and the 

orientation was Intersecting Runways. Click a response to navigate back to the question 

and change the response. 
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In the example below, the dialog box now indicates that the orientation was Same 

Runway, Tail Chase and the first landing aircraft landed. 
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The last dialog box displays the scenario number and a summary description of the 

scenario that generated the number. If the Scenario Selection Tool was accessed from a 

calculator dialog box, the tool asks if you want to bring the scenario number back to the 

calculator as in the example below. 

  

 

 

RISC Measurements and Settings 

The RISC Measurements and Settings dialog box lets you set the default units of measure 

you will use to calculate a severity rating on the RISC calculator dialog boxes. The RISC 

Measurements and Settings dialog box also allows you to specify whether the model uses 

FAA or ICAO rating ranges in its calculations. 

To access the RISC Measurements and Settings dialog box, click the Measurements and 

Settings button on the RISC Main dialog box. 

  

Note: You can also access the RISC Measurements and Settings dialog box by 

selecting the Measurements and Settings option on the file menu of the RISC Main 

dialog box. 
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RISC Measurements and Settings Main Menu 

The main menu on the RISC Measurements and Settings dialog box provides access to 

the File and Help menus. The File menu provides options for saving new measurements 

settings, opening the calculator, and exiting the RISC Measurements and Settings dialog 

box without saving changes to the settings. The Help menu provides options for 

accessing Help and viewing RISC version information. 
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Using the RISC Measurements and Settings Dialog Box 

The RISC Measurements and Settings dialog box provides radio buttons for setting 

default units of measure for: 

• Horizontal Proximity 

• Vertical Proximity 

• RVR (Runway Visual Range) 

• Visibility 

• Ceiling 

• Avoidance Maneuvers 

 

You can set the calculator to use Feet (ft) or Meters (m) for closest proximity or 

avoidance maneuvers when calculating a severity rating. In addition to Feet (ft) or Meters 

(m), you can set the calculator to use Nautical Miles (NM), Statute Miles (SM), or 

Kilometers (km) for RVR, Visibility, and Ceiling. To select a unit of measure, click the 

radio button for the measurement you want to use.  

The RISC Measurements and Settings dialog box also provides radio buttons for 

specifying FAA or ICAO users. These radio buttons determine whether the RISC system 

uses FAA or international rating ranges when calculating a rating. For more information 

on FAA and ICAO ratings, see the topic How the Calculator Works. 

  

Note: If you open the calculator and then change the default units of 

measure on the RISC Measurements and Settings dialog box, you must 

open a new session of the calculator for the settings to take effect. 
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Using RISC 

 

Closest Proximity and Avoidance Maneuvers 

In the Avoidance section of the calculator, enter the closest horizontal and/or vertical 

proximity of the object or objects involved. You must enter a value of zero or greater. 

At times, entering a closest proximity requires using a formula. These formulas are 

known as Special Calculations. To aid in calculating closest proximity, here is a list of 

the Special Calculations that are used for RISC. 

� Case 1: Computing closest horizontal proximity for any scenario involving an 

aircraft that goes around.   CHP = DGAR + DAC2 , where: 

o CHP =  Closest Horizontal Proximity 

o DGAR = The landing aircraft’s distance away form the Approach end of 

the runway when it begins to go around. 

o DAC2 = The other aircraft/vehicle/pedestrian’s distance away from the 

approach end of the runway (0 if it is at the approach end.) 

� Case 2: Computing closest horizontal proximity for any scenario involving one 

aircraft passing an aircraft/vehicle/pedestrian on a taxiway or the shoulder of the 

runway. CHP =  [(RWidth / 2) – (WAC1 / 2)] + DAC2 , where: 

o CHP = Closest Horizontal Proximity 

o RWidth = The width of the Runway 

o WAC1 = Wingspan of the aircraft that is passing. 

o DAC2  = The other aircraft/vehicle/pedestrian’s distance from the runway 

edge line (0 if the closest portion of the aircraft is on the edge line, 

positive if the aircraft is over the hold line, negative if the aircraft is 

partially or completely on the runway. 

� Case 3: Computing closest vertical proximity for any scenario involving one 

aircraft flying directly over another aircraft at a close distance.  This calculation is 

not frequently used, but may be necessary depending on the type of information 

that is available from incursion reports.   CVP = DAC1 - TAC2  , where: 

o CVP = Closest Vertical Proximity 

o DAC1 = The over-flying aircraft’s distance from the ground. 

o TAC2 = Tail Height of aircraft being over-flown. 

Field Validation and Error Checking 

After you respond to the fields on the calculator, click the Save and Calculate (database 

version) or the Calculate Rating (calculator version) button. 
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Before displaying a severity rating, the calculator checks that you have answered all 

fields. If a field is left blank, RISC flags the field with a red and white exclamation icon. 

In addition to the icon, the RISC (Calculator Version) dialog box will display an error 

message as in the graphic below.  

 

 

Error Messages 

 

The RISC system displays error messages to inform users of problems with installation, 

startup, or with data input. An error message typically provides an explanation of the 

problem and instructions on how to correct it as in the example below. 

  

 

 

Installation Errors  

The following are error messages you may encounter when installing RISC or running 

RISC for the first time after installation. 

 

Installation Errors 

Error Name Error Text Explanation 

 

RISC Calculator 

Form Load 

 

"Could not find file "C:\Program 

Files\RISC_Model (database 

name)". 

 

Database file was renamed or 

not found in the installation 

directory. Reinstall the 

application. 

 

 

RISC Calculator 

Form Load 

 

"The .Net Data OLE DB Provider 

(System.Data.OleDb) requires 

Microsoft Data Access 

Components(MDAC) version 2.6 

or later. Version 2.53.6200.0 was 

 

You are using a Windows 

2000 operating system but do 

not have Microsoft Data 

Access Component (MDAC) 

2.6 or higher installed. 
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found currently installed." Navigate to the MDAC_28 

folder on the installation CD 

and double-click the MDAC 

.exe file. 

  

 

RISC 

Calculator.exe - 

Unable to Locate 

DLL 

 

"The dynamic link library 

mscoree.dll could not be found in 

the specified path..." 

 

You are using a Windows 

2000 operating system and 

do not have Microsoft.NET 

Framework installed. 

Navigate to the net 

framework 1.1 folder on the 

installation CD and double-

click the dotnetfx.exe file. 

  

 

RISC 

Calculator.exe - 

Application 

Error 

 

"The application failed to 

initialize properly (0xc0000135). 

Click on OK to terminate the 

application." 

 

You are using a Windows 

XP operating system and do 

not have Microsoft.NET 

Framework installed. 

Navigate to the net 

framework 1.1 folder on the 

installation CD and double-

click the dotnetfx.exe file. 

  

 

RISC Calculator Errors 

The following are error messages you may encounter when using RISC to calculate a 

severity rating. 

  

Calculator Errors 

Error Name Error Text Explanation 

 

RISC Calculator - 

Field 

Validation(s)RISC 

(Calculator 

 

"You have not selected a value 

for (field name). The above 

field(s) are required. Please 

check your inputs and try 

again." 

 

One or more required fields 

are blank. Respond to the 

indicated fields.  
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Version) only   

   

RISC Calculator - 

CP/Scenario  

   

"You have specified a vertical 

proximity for a scenario that 

does not use a vertical matrix. 

Fix your proximity information 

or change the scenario you've 

chosen." 

  

   

The scenario selected 

describes an incursion with a 

horizontal proximity but a 

vertical proximity was 

entered. Enter 0 for vertical 

proximity and enter a value 

greater than 0 for horizontal 

proximity or change the 

scenario. 

 

RISC Calculator - 

CP/Scenario 

   

"You have specified a 

horizontal proximity for a 

scenario that does not use a 

horizontal matrix. Fix your 

proximity information, or 

change the scenario you've 

chosen." 

  

   

The scenario selected 

describes an incursion with a 

vertical proximity but a 

horizontal proximity was 

entered. Enter 0 for 

horizontal proximity and 

enter a value greater than 0 

for vertical proximity or 

change the scenario. 

 

RISC Calculator - 

CP/Scenario 

   

"You have specified two 

proximity values. This scenario 

does not use two proximities to 

determine a rating.  Enter one 

proximity value, or change the 

scenario you've chosen" 

  

   

The scenario selected 

describes an incursion with 

one proximity only but both 

horizontal and vertical 

proximities were entered. 

Enter one proximity or 

change the scenario. 

 

RISC Calculator - 

CP/Scenario 

 

"You forgot to enter a proximity 

value." 

 

Closest proximity is required 

data. Enter a value greater 

than 0 for either horizontal or 

vertical proximity. 

RISC: Scenario 

Mismatch 

The scenario number does not 

correspond with your choice for 

incident type.  Please choose 

another scenario from the list 

In RISC, there are some 

Scenarios that are not 

permitted depending on the 

user’s choice for incident 
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or change your incident type. type.   

 

RISC Calculator - 

CP/Scenario 

 

"The (horizontal or vertical) 

proximity must be 0 or greater." 

 

RISC accepts a value of 0 or 

greater for closest proximity. 

For example, you cannot 

enter a negative value (e.g. -

500) or an alpha character for 

closest proximity. Enter a 

value greater than 0 for 

closest proximity. 

  

 

Displaying Error Text by Field 

When calculating a rating, RISC will display an error message and flag a field with a red 

and white exclamation icon if the field was left blank or incorrectly answered. As you 

correct problems with data input, you can display error text for a field by positioning the 

pointer over the red and white exclamation icon as in the example below. 

  

 

Using RISC (Database Version) 

In addition to calculating a severity rating, the RISC (Database Version) allows you to 

maintain a database of saved incursion records by providing the capability to:  

  

• add new incursion reports to the database 

• enter a number and date for each report 

• browse a date range of incursion records 
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• save incomplete reports 

• edit saved incursion reports 

• export incursion records for analysis 

• delete incursion records from the database 

 

RISC Toolbar 

The RISC (Database version) dialog box provides a toolbar for managing incursion 

records saved to the database. The toolbar displays the date range of the incursions 

selected for viewing and provides the capability to specify a new date range, browse 

records, export records, clear the calculator to enter a new record, and delete records from 

the database. 

  

 

Changing the Date Range of Records Displayed 

To change the date range of records displayed, click the Change button on the toolbar. 

The RISC Change Dates dialog box opens. 

  

 

 

To change the start or end date, click the month, date, or year in the date field and type a 

new value or use the calendar popup. After you click OK, the dates you specified display 

in the "Incursions from" date range at the left end of the RISC toolbar and the first report 

in the date range is available for editing. 
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To display a single report from the database, enter the report date in both the Start Date 

and End Date fields. If more than one record exists with that report date, you may need to 

browse the records to find the report. 

To close the RISC Change Dates dialog box without changing the date range, click 

Cancel. 

Browsing Records 

The RISC toolbar provides left and right arrow buttons for browsing incursion records. 

After selecting records within a specified range of dates, the first record within the date 

range displays on the calculator. In the example below, the record counter indicates that 

the record currently displayed is the first of a total of two. 

 

 
 

Use the right arrow button to display the next record in the date range. As you browse 

incursion records you can use the left arrow button to display the previous record in the 

date range. Use the left arrow button with a vertical line to display the first record in the 

date range and the right arrow button with a vertical line to display the last record in the 

date range. 

Exporting Records 

Using this function you can export the incursion record currently displayed, or a date 

range of incursion records, to a Comma Separated Value file (CSV). Excel recognizes the 

.CSV file type. 

Click the Export... button on the toolbar to open the RISC Export dialog box. 
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To export the incursion currently displayed on the calculator, click the Current Incursion 

radio button and OK. To export incursion records within a specified date range, click the 

Date Range radio button. To change the start or end date, click the month, date, or year in 

the date field and type a new value or use the calendar popup. After specifying a date 

range, click OK. The Save As dialog box opens. On the Save As dialog box you select 

the location in which you want to save the .CSV file and enter a file name. Click the Save 

button to save the file. 

To close the RISC Export dialog box without exporting any records, click the Cancel 

button. 

Adding a New Report 

To add a new report to the database, use the New button on the toolbar. The New button 

clears the calculator allowing you to enter data on a new incursion. After clicking the 

New button, the Delete button on the toolbar changes to a Cancel button. To return to the 

date range of records you previously selected without saving a new report, use the 

Cancel button. 

 

Note: When there are no records present in the selected date range, the RISC form may 

appear empty.  However, to enter a new report into the database, you must still press 

the New button in order to do so.  Entering data in a blank form without first pressing 

the New button will result in a loss of that data when the user presses the Save and 

Calculate button. 
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The calculator allows you to select an incident type and the "Database Version" provides fields for 

entering a report number and date. These are required fields for saving reports to the database and do 

not display on the RISC (Calculator Version) dialog box. 

You can enter a report number using any combination of alpha and/or numeric characters. 

The current date displays as the default report date. To change the date that displays, 

click the month, date, or year in the date field and type a new value or use the calendar 

popup.  

 

Note: The report date cannot be a future date. 

 

After you respond to all fields on the calculator, click the Save and Calculate button. If 

the field data passes all checks, an FAA or ICAO alpha severity rating and its 

corresponding numeric rating displays in the Rating field and the new incursion report is 

added to the database. The incursion report you entered displays on the calculator and is 

available for editing. The Incursions from date range is updated to reflect the fiscal year 

for that report. The record counter is updated to reflect the number of incursions for that 

fiscal year. 
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Note: You set the RISC model to use FAA or ICAO rating ranges in the 

Measurements dialog box.  For more information on the ratings themselves, see the 

topic How the Calculator Works. 

 

Deleting Records 

To delete the incursion record currently displayed, click the Delete button. A 

confirmation dialog box displays asking you to confirm you want to delete the incursion 

record. 

Saving an Incomplete Report 

You can save an incomplete report to the database by leaving any calculator fields blank 

with the exception of the Report Number and Report Date fields. An incomplete report is 

saved to the database after you click the Save and Calculate Rating button. The RISC 

(Database Version) dialog box flags unanswered fields on incomplete reports with red 

and white exclamation icons as in the example below. 
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Editing a Saved Report 

You can edit data in any saved report (complete or incomplete) in the database. After you 

edit a field value in a previously saved report, the severity rating field displays blank 

requiring you to save the edited report and recalculate a rating. 

 


